
ВВЕДЕНИЕ

В предыдущей части статьи [1] был

рассмотрен сценарий, осуществляю�

щий расчёт и построение схемы по�

лосно�пропускающего фильтра (ППФ)

на сосредоточенных элементах в среде

Microwave Office. В данной статье мы

рассмотрим возможный подход к про�

ектированию полосно�пропускающе�

го фильтра (ППФ) в волноводном ис�

полнении в программе HFSS. В част�

ности, мы опишем процесс создания

программы – сценария на языке Visual

Basic Scripting Edition, осуществляю�

щего построение модели фильтра. Для

удобства использования сценария в

него добавлены диалоговые окна.

ПРОЕКТИРОВАНИЕ

ВОЛНОВОДНОГО ППФ
НА ИНДУКТИВНЫХ ДИАФРАГМАХ

Если начинать процесс проекти�

рования СВЧ�фильтра в программе

трёхмерного электродинамического

моделирования «с нуля», без предвари�

тельной оценки характеристик и па�

ПРОЕКТИРОВАНИЕ И МОДЕЛИРОВАНИЕ

58 WWW.SOEL.RU СОВРЕМЕННАЯ ЭЛЕКТРОНИКА ◆ № 7  2012

раметров геометрии с помощью не�

кой упрощённой модели (инженерной

оценки), то процесс синтеза фильтра

может потребовать больших затрат

времени даже на современных персо�

нальных компьютерах (ПК).

Основываясь на рассчитанных но�

миналах LC�элементов рассмотренно�

го [1] фильтра�прототипа на сосредо�

точенных элементах, можно перейти

к конструкции фильтра, например, в

микрополосковом исполнении, при�

менив т.н. преобразование Ричарда для

определения схемы фильтра на основе

отрезков линии передачи с последую�

щим её пересчётом в полосковую

конструкцию. В работе [2] приведён

пример реализации подобной цепоч�

ки проектирования микрополосковых

фильтров, при этом расчёты выполне�

ны в пакете MATLAB, а окончательная

модель устройства проверена методом

конечных разностей во временной об�

ласти. Однако такую методику нельзя

применить для расчёта волноводного

ППФ на индуктивных диафрагмах.

Зададим порядок фильтра N = 5, по

аналогии с [1]. Геометрия соответству�

ющего ППФ на индуктивных диафраг�

мах изображена на рисунке 1. При

проектировании ППФ на индуктив�

ных диафрагмах можно использовать

эквивалентные схемы фильтров�про�

тотипов, приведённые на рисунке 2. В

этом случае можно выделить следую�

щие четыре возможных последова�

тельных этапа синтеза:

1)расчёт ППФ – прототипа на сосредо�

точенных элементах [1];

2)расчёт ППФ – прототипа с инверто�

рами импеданса (см. рис. 2а);

3)расчёт «полудискретной» модели

фильтра с отрезками линии переда�

чи и параллельно включенными ин�

дуктивностями (см. рис. 2б);

4)определение трёхмерной геометрии

ППФ на индуктивных диафрагмах,

моделирование полученной струк�

туры одним из методов численной

электродинамики.

Начиная со второго этапа, структуры

фильтра основываются на данных, по�

лученных на предыдущем этапе.

В работе [3] предварительные стадии

синтеза были реализованы в пакете

MATLAB. Представляется возможным

реализовать соответствующие вычис�

ления и рассчитать полученные пред�

варительные модели непосредственно

в среде Microwave Office, как это было

сделано для первой стадии проектиро�

вания [1], тем более что в базе элемен�

Автоматизация процесса проектирования антенн
и устройств СВЧ в современных программных
комплексах электродинамического
моделирования
Часть 4. Волноводный фильтр на индуктивных диафрагмах

Андрей Пластиков (Москва)

Рассмотрена методика проектирования волноводного полосно�

пропускающего фильтра с индуктивными диафрагмами в программных

пакетах AWR Microwave Office и Ansoft HFSS. Описан процесс создания

сценария на языке VBScript, осуществляющего автоматизированное

построение модели фильтра произвольного порядка в программе HFSS

на основе параметров геометрии, введённых пользователем. В качестве

примера спроектирован фильтр сантиметрового диапазона волн.

L
0

L
1

d
1

y

z
x

d
2

d
3

d
4

d
5

d
6

a

b

L
2

L
3

L
4

L
5

Рис. 1. Проектируемый волноводный ППФ Рис. 2. Эквивалентные схемы волноводного ППФ с индуктивными диафрагмами
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тов этой программы есть и модели иде�

альных инвертеров импеданса. Но в

рамках данной статьи мы не будем рас�

сматривать промежуточные этапы

синтеза и для получения предвари�

тельной модели ППФ на индуктивных

диафрагмах сразу воспользуемся на�

бором волноводных элементов в среде

Microwave Office. В качестве примера

рассмотрим фильтр сантиметрового

диапазона волн.

РАСЧЁТ ФИЛЬТРА В ПРОГРАММЕ

MICROWAVE OFFICE

Предварительные расчёты и опти�

мизацию геометрии проектируемого

ППФ на индуктивных диафрагмах мы

проведём в программе Microwave Of�

fice. Основные требования к частот�

ным характеристикам фильтра были

выбраны аналогичными рассмотрен�

ной [1] модели фильтра на сосредото�

ченных элементах, за исключением

уровня заграждения в полосе затуха�

ния (ПЗ): центральная частота полосы

пропускания (ПП) 10 ГГц; ширина ПП

1,2 ГГц; порядок фильтра 5; ослабление

в ПП Lp = 0,05 дБ, что соответствует

уровню коэффициента отражения

около –19,5 дБ; граничная частота ПЗ

12 ГГц; уровень заграждения в полосе

затухания –30 дБ. Зададимся прямо�

угольным волноводом сечением 23 ×
× 10 мм и толщиной диафрагм 1,5 мм.

На рисунке 3 изображена схема вол�

новодного ППФ, составленная из ба�

зовых элементов среды Microwave

Office. Отметим, что с обоих концов

схемы мы разместили «идеальные» ко�

аксиально�волноводные переходы

(элементы COAXRWG_TE10). Это поз�

волило избавиться от портов с частот�

но�зависимой величиной входного

сопротивления (волновое сопротив�

ление прямоугольного волновода яв�

ляется функцией частоты) и исполь�

зовать для возбуждения порты с по�

стоянным сопротивлением 50 Ом. Чис�

ло высших типов волн, учитываемых

при расчётах диафрагм (элементы

RWGIRIS_TE10), задано равным 10. В

процессе оптимизации мы ограничи�

лись рассмотрением структуры фильт�

ра, симметричной относительно цент�

рального резонатора.

Частотные характеристики итого�

вой модели фильтра, рассчитанные в

диапазоне частот от 7 до 13 ГГц, изоб�

ражены на рисунке 4, где для сравне�

ния приведены также соответствую�

щие зависимости прототипа такого

ППФ, построенного на дискретных LC�

элементах [1]. Обращает на себя вни�

мание расхождение зависимостей мо�

дуля коэффициента передачи в облас�

ти ПЗ со стороны высоких частот. Дан�

ная особенность ППФ в волноводном

исполнении связана с наличием час�

тотной дисперсии, которая не учиты�

вается в прототипе фильтра из дис�

кретных элементов [3].

Далее мы используем полученные

параметры геометрии для построения

структуры такого ППФ в программе

HFSS. При этом для построения самой

модели напишем программу�сценарий

на языке VBScript, которая позволит

автоматизировать процесс создания

модели в данной САПР.

ПЕРВОЕ ЗНАКОМСТВО

СО СЦЕНАРИЯМИ В HFSS
Программа HFSS позволяет пользо�

вателю составлять программы�сцена�

рии на языках Visual Basic Scripting Edi�

tion или JavaScript. Мы ограничимся

рассмотрением первого из них.
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Рис. 3. Схема волноводного ППФ с индуктивными диафрагмами в среде Microwave Office

Рис. 4. Частотные характеристики ППФ в Microwave Office

а) для схемы волноводного фильтра; б) для фильтра�прототипа на сосредоточенных элементах [1]
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Visual Basic Scripting Edition (VBScript) –

это т.н. язык сценариев программиро�

вания, разработанный для записи по�

следовательностей операций, которые

пользователь может выполнить на

компьютере. Данный язык был создан

компанией Microsoft и достаточно ши�

роко используется при создании сцена�

риев в операционных системах семей�

ства Windows. В сценариях, написан�

ных на VBScript, взаимодействие с

пользователем может осуществляться

с помощью функций MsgBox и Input�

Box, которые представляют собой

простейшие диалоговые окна для вы�

вода сообщений и ввода пользовате�

лем текста или числа.

Программный пакет HFSS способен

самостоятельно генерировать файл

сценария на языке VBScript из опе�

раций пользователя, выполненных в

CAD�интерфейсе самой программы.

Используя эту возможность, созда�

дим в качестве примера простой сце�

нарий.

Запустим программу HFSS и удалим в

окне менеджера проектов пустой про�

ект Project 1 (название по умолчанию).

Запустим процесс записи действий

пользователя в файл сценария *.vbs,

выбрав в меню команду Tools → Record

Script To File и указав в появившемся

окне диалога название и местополо�

жение создаваемого файла. Теперь

последовательно выполним следую�

щие операции:

1)создадим новый «глобальный» про�

ект Project1 (File → New);

2)введём в него проект для расчёта

методом конечных элементов (Pro�

ject → Insert HFSS Design);

3)зададим частоту (10 ГГц) и парамет�

ры адаптивного разбиения на ячей�

ки (Add Solution Setup);

4)установим параметры частотной

развёртки (Add Frequency Sweep) в

диапазоне частот от 7 до 13 ГГц.

На этом завершим процесс записи

сценария, выполнив команду Stop

Script Recording в ветке меню Tools.

Содержание созданного файла сце�

нария отображено в листинге 1 (этот и

другие листинги см. на сайте журна�

ла). Строки с комментариями начина�

ются с символа апострофа, при этом

приведённые в листинге русскоязыч�

ные комментарии введены в этот код

дополнительно. В начале сценария с

помощью директивы Dim объявлены

переменные, которым затем посредст�

вом директивы Set присвоены объек�

ты программного кода среды HFSS. Ха�

рактерным для языка VBScript является

отсутствие необходимости принуди�

тельного задания типа переменной

при её объявлении, т.к. всем перемен�

ным по умолчанию присваивается тип

Variant.

Установка частоты и параметров

адаптивного разбиения производится

командой вида oModule.InsertSetup

«HfssDriven», вслед за которой прово�

дится задание массива Array(...) значе�

ний параметров – атрибутов данной

операции: названия, частоты разби�

ения, критериев сходимости и пр. В

нашем случае этот массив содержит

22 атрибута за исключением названия.

При задании параметров объектов в

конструкции Array(.. .) допустимо не

указывать некоторые из них, тогда

соответствующим атрибутам будут

присвоены значения по умолчанию.

Следующая затем команда InsertFre�

quencySweep производит настройку

развёртки по частоте для созданного

выше адаптивного разбиения Setup 1.

Отметим, что для переноса текста ко�

манды на следующую строку следует

использовать символ нижнего подчер�

кивания «_» в конце текущей строки.

Таким образом, синтаксис конкрет�

ной команды с полным набором атри�

бутов можно изучить, используя воз�

можность HFSS самостоятельно гене�

рировать код файла сценария.

Запуск программы�сценария в сре�

де HFSS можно произвести командой

меню Tools → Run Script. Запустить вы�

полнение сценария можно также и не�

посредственно из окна файлового ме�

неджера в ОС Windows, если соответ�

ствующий файл *.vbs будет открыт в

программе�интерпретаторе Microsoft

Windows Script Host. В этом случае нет

необходимости заранее запускать па�

кет HFSS. Дополнительно имеется воз�

можность добавления созданного

пользователем сценария построения

модели в библиотеку графических

примитивов HFSS, доступную из меню

Draw → User Defined Primitive. Для этого

в редакторе VBScript на основе файла

сценария *.vbs необходимо скомпили�

ровать файл динамической библиоте�

ки *.dll.

Заметим, что в пакете HFSS отсут�

ствует встроенный редактор сценари�

ев, вследствие чего просмотр и написа�

ние текста сценариев необходимо про�

водить с помощью внешних программ.

Поскольку файлы сценариев на языке

VBScript представляют собой тексто�

вые файлы с командами, их можно

просматривать и редактировать в

обычной программе «Блокнот». Одна�

ко более удобным представляется ис�

пользовать для этой цели специальные

текстовые редакторы, «понимающие»

синтаксис языков программирования

и выделяющие их команды различным

цветом. Примером такого редактора

является свободно распространяемая

программа Notepad++ [4].

НАПИСАНИЕ СЦЕНАРИЯ

ДЛЯ ПОСТРОЕНИЯ МОДЕЛИ

ВОЛНОВОДНОГО ФИЛЬТРА

Дополним созданный файл сцена�

рия кодом, осуществляющим построе�

ние модели волноводного ППФ на ин�

дуктивных диафрагмах. Структура соз�

даваемого в HFSS фильтра будет

аналогична изображённой на рисун�

ке 1, за исключением использования

диафрагм конечной толщины t. Для

сокращения объёма задачи предусмот�

ПРОЕКТИРОВАНИЕ И МОДЕЛИРОВАНИЕ
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Рис. 5. Диалоговое окно для ввода параметра

геометрии

Рис. 6. Модель ППФ, построенная при помощи сценария
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рим введение идеальной магнитной

стенки в плоскости симметрии. Поря�

док фильтра и его геометрические па�

раметры будут вводиться пользовате�

лем в диалоговых окнах.

Сначала объявим переменные, опи�

сывающие геометрию модели ППФ,

добавим диалоговые окна для ввода

пользователем значений этих пере�

менных и введём их в проект в качест�

ве локальных переменных. Текст кода

соответствующей части сценария при�

ведён в листинге 2. Каждая перемен�

ная вводится в отдельном окне, вызы�

ваемом функцией InputBox. Последние

три аргумента данной функции, зада�

ющие выводимое в текстовом окне

значение по умолчанию и положение

самого окна на экране, являются не�

обязательными и могут быть опуще�

ны. Пример такого диалогового окна

показан на рисунке 5. Заметим, что для

корректного отображения русско�

язычных символов автору пришлось

сменить исходную кодировку файла

сценария на ANSI, а корректный ввод

дробных чисел удалось обеспечить

благодаря смене в ОС Windows 7 фор�

мата языка и региональных стандар�

тов на английский.

Далее создадим отрезок прямоуголь�

ного волновода длиной Lfull, зададим

плоскость H�симметрии и множитель

импеданса, установим волноводные

порты (с заданными интегральными

линиями) со стороны каждого из двух

торцов, в цикле For...Next создадим не�

обходимое число диафрагм с заданны�

ми параметрами, а затем «вырежем» из

отрезка волновода эти диафрагмы по�

средством булевой операции вычита�

ния (см. листинг 3). Отметим, что для

команды создания прямоугольного па�

раллелепипеда CreateBox требуется за�

давать два массива аргументов: первый

содержит параметры геометрии, а вто�

рой задаёт такие атрибуты создавае�

мого элемента, как название, цвет,

прозрачность, материал и др. Для при�

мера в листинге 3 также показано ис�

пользование команды ChangeProperty

для изменения значения прозрачнос�

ти созданного отрезка волновода.

Создаваемая таким сценарием мо�

дель фильтра является полностью па�

раметризированной, что позволяет

при необходимости проводить её оп�

тимизацию.

В заключительной части кода сцена�

рия добавим в проект вывод результа�

тов расчёта модулей коэффициентов

передачи S21 и отражения S11 в лога�

рифмическом масштабе, сохраним

сам проект, проведём расчёт создан�

ной модели ППФ, а по его окончании

выведем на экран соответствующее со�

общение. Текст данной части сцена�

рия приведён в листинге 4.

РАСЧЕТ ФИЛЬТРА В ПРОГРАММЕ

HFSS
Полученные в программе Microwave

Office параметры геометрии ППФ бы�

ли использованы при создании моде�

ли фильтра сценарием, написанным в

HFSS. Построенная сценарием модель

изображена на рисунке 6. Частотные

характеристики рассчитанной струк�

туры фильтра представлены на рисун�

ке 7, где для наглядности приведены

также аналогичные зависимости, по�

лученные в Microwave Office. Данные

графики очень хорошо согласуются

друг с другом, следовательно, исполь�

зованные при моделировании в Mic�

rowave Office волноводные компонен�

ты позволяют получать адекватные ре�

зультаты.

На рисунке 8 отображено мгновен�

ное распределение модуля электричес�

кого поля в полной модели фильтра на

центральной частоте ПП и на границе

ПЗ при подаче мощности на один из

входов. Данная визуализация иллюст�

рирует процесс распространения и за�

тухания волны в фильтре.

ЗАКЛЮЧЕНИЕ

В статье рассмотрена методика про�

ектирования волноводного ППФ про�

извольного порядка в САПР Ansoft

HFSS, включающая в себя проведение

предварительных расчётов в програм�

ме Microwave Office. Создание трёхмер�

ной модели фильтра осуществлено

посредством сценария, написанного

на языке VBScript. Синтаксис конкрет�

ных команд языка сценариев можно

изучить, используя возможность HFSS

самостоятельно генерировать код фай�

ла сценария.

Результаты расчёта волноводного

ППФ на индуктивных диафрагмах,

проведённые в обеих программах, хо�

рошо согласуются друг с другом. Это

позволяет рекомендовать пакет Mic�

rowave Office для проведения предва�

рительной оптимизации фильтров по�

добной топологии, а пакет HFSS – для

окончательных расчётов с учётом осо�

бенностей конкретного конструктив�

ного исполнения, например, техноло�

гического скругления краёв резонато�

ров при фрезеровании.
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Рис. 7. Сопоставление частотных характеристик,

полученных в HFSS и Microwave Office

Рис. 8. Распределение модуля электрического поля внутри фильтра в ПП на частоте 10 ГГц (слева)

и ПЗ на частоте 12 ГГц (справа)
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